
Computer
Secrets
Unleashed!

Go And Play With Your Computer

          

                                      By:  Biswajit Dey



1.  Hide drive
Go to Start > run > type "diskpart". 
A DOS window will appear with following discription. 
DISKPART> 

2. Then type "list volume" 

The result will look like : ------
Volume ### Ltr Label Fs Type Size Status Info 
--------------- --- -------- ---- ------ ---- ------ ----

Volume 0 F CD-ROM 
Volume 1 C Window_XP NTFS Partition 7000MB Healthy System 
Volume 2 D Softwares NTFS Partition 8000MB Healthy 
Volume 3 E Songs NTFS Partition 8000MB Healthy 

3. Suppose u wanna hide drive E then type "select volume 3". Then a message will appear 
in same winwods { Volume 3 is the selected volume} 

4. Now type "remove letter E". Now a message will come { Diskpart Removed the Drive 
letter } 
sometime it requires the reboot the computer. Diskpart will remove the letter. Windows 
XP is not having capabilty to identify the unkown volume. 

Your Data is safe now from all unauthorised users. To access the content of hidden Drive 
repeat the process mentioned above. But in 4th step replace " remove" to "assign" i mean 
type "assign letter E

2. Locking Folders: 

Consider you want to lock a folder named in your E:\, whose path is E:\. 
Now open the Notepad and type the following 

ren .{21EC2020-3AEA-1069-A2DD-08002B30309D} 

Where is your folder name. Save the text file as loc.bat in the same drive. 
Open another new notepad text file and type the following 

ren .{21EC2020-3AEA-1069-A2DD-08002B30309D} 

Save the text file as key.bat in the same drive. 
Steps to lock the folder: 

To lock the folder, simply click the loc.bat and it will transform into control panel icon 
which is inaccessible. 
To unlock the folder click the key.bat file. Thus the folder will be unlocked and the 
contents are accessible



3. How to clean the virtual memory pagefiles 

You can make your computer automatically clear the virtual memory pagefiles whenever 
you shut down your computer. To do this, follow the steps below: 
1. Click Start, then click Run... 
2. Type "regedit" then click OK. The Registry Editor will be displayed. 
3. In the left menu, expand the following registry keys in this order: 
HKEY_LOCAL_MACHINE, SYSTEM, CurrentControlSet, Control, Session Manager 
4. Click the Memory Management folder, 
5. In the right pane, double-click ClearPageFileAtShutdown. The Edit DWORD Value 
window will be displayed. 
6. Type 1 in the Value data field, then click OK. 
7. Exit the Registry Editor. 
8. Restart your system so the changes can take affect.

4. The Windows XP System Properties logo is often changed by computer 
manufacturers.

 Hardware vendors use this general system information dialog to brand your computer 
with their own logo and support contact information. 

In this tip you can learn how you can insert your own logo in the system properties dialog 
and complete it with your own contact information. 

To invoke the system properties dialog, click the Start button, right-click "My Computer" 
and select "Properties". 

This will open up your general system information dialog. On our Fujitsu-Siemens Amilo 
Pro laptop, the Windows XP System Properties logo looks like this : 

If you want to put your own graphic in there, you should create your image in a .bmp 
graphic file. Itâ€™s also a good idea to create this bitmap image with the same 
background shade of gray (RGB: 192, 192, 192) used in the Properties dialog. Otherwise, 
you risk letting Windows make its own judgments regarding color contrast and 
background shading. 

The next thing to consider is the image size. The system properties dialog only offers 
enough real estate for an image of about 180 (wide) x120 (high) pixels. Make sure that 
you can fit your logo in this area. 

Once you have created your logo and saved it as a .bmp file, copy it over to the system32 
subfolder of your Windows system folder. If you donâ€™t know where your system folder 
is : 

- Click the Start button and select "Run" 



- In the "open" field, enter "cmd" (without the quotes) and click ok 
- Windows will open up a dos command window 
- In the command window, type "set system" (without the quotes) 
- Look for the line that contains "SystemRoot", this is where your system directory is 
(generally, the Windows XP system folder is c:\windows) 

Now that you know where your system folder is, copy your logo image file over to the 
system32 subfolder of your system folder. Then rename your logo image file to 
oemlogo.bmp 

Additionally you can create a new file in this same folder and name the new file 
oeminfo.ini 

In this file you can enter your contact information like in the example below : 

[General] 
Manufacturer=Your Company Name 
Model=ShowCase 

[Support Information] 
Line1=" " 
Line2=" For support, sales, upgrades or questions:" 
Line3="" 
Line4=" Some text to demonstrate the XP System Properties logo" 
Line5=" Windows XP PC " 
Line6=" Your Company Name" 
Line7="" 
Line8=" +1 (888) 888-888 (voice)" 
Line9=" +1 (888) 888-889 (fax)" 
Line10="" 
Line11="" 
Line12=" http://www.Your Company Name.com/" 

Save and close the file and you are ready. From now on, if someone opens up the system 
properties dialog, your own Windows XP System Properties logo is in there.

5.  Changing ANY user password without having to know the existing password .

warning use at your own risk 

This tweak gives a user the opportunity to use it for good or bad. It enables the user to 
re-password any account without having to know the existing password and also shows 
you every account that exists on the machine (even the ones that are hidden). This is a 
good tool to use if you forgot a password to say your administrator account and you 
needed to be logged into the admin account for any reason. 

To view all of the user accounts: 

1) While logged onto the computer, click on Start>Run>and type in CMD. 

2) From the command prompt window, type in net users. This will show you every account 
that is made onto the computer whether it is hidden or not. 



-----------------------------------------------------------------

To change an account password: 

1) While logged onto the computer to an account that has administrative rights, click on 
Start>Run>and type in CMD. 

2) Type in net user then the name of the account then * and press enter. heres an 
example: net user administrator * or net user "Joe Smith" * . Put the name in quotes if it 
contains spaces. 

3) From there it should ask for a new password. Type in your new password (type very 
carefully - the command window won't display what you type) and once more to confirm 
it. If you get the message that the command succeeded successfully you're all set!! 

warning use at your own risk

6. Virtual memory page file.

           Defragging and setting a rigid area for your Page File can sometimes drastically 
increase memory performance and your systemâ€™s ability to multi-task. Unfortunately, Disk 
Defragmenter doesnâ€™t touch the Page File. There are two ways to defrag it. 

One way to defrag the page file is to download and install PageDefrag Utility. The 
programâ€™s window displays a list of files and how fragmented they have become. To 
defrag the page file, select â€œDefragment at next bootâ€• and hit OK. The next time you 
restart, this program will defrag the listed files. 

If you want to go the â€œtried and testedâ€•, yet time consuming route without using any 
third-party applications, and have a separate hard drive/partition, this procedure will work 
every time. First, move the page file to the separate drive/partition. In XP, go to Control 
Panel > System > â€œAdvancedâ€• tab and under â€œPerformanceâ€•, click 
â€œSettingsâ€•. Go to the â€œAdvancedâ€• tab and under â€œVirtual Memoryâ€•, click 
â€œChangeâ€•. In 2000, go to Control Panel > System > â€œAdvancedâ€• tab; click 
â€œPerformance Optionsâ€• and then â€œChangeâ€•. Select the drive letter that displays 
the Page File size. Select â€œNo paging fileâ€• and hit â€œSetâ€•. Next, select the 
separate hard drive/partition. Select â€œCustom Sizeâ€• and set the Initial Size and the 
Maximum equal to 1.5 to 2 times greater than the total of systemâ€™s RAM. For example, if 
your system has 512MB of RAM, set the two values equal to 1024MB. Hit â€œSetâ€• and OK 
after youâ€™re done. Reboot when prompted. 

Now, defrag the drive/partition your Operating System is on. Itâ€™s best if this is done in
safe mode and overnight when the computer doesnâ€™t need to be used. 

After defragging is completed, go to into â€œVirtual Memoryâ€•, per the directions listed 
earlier, and select the drive letter that displays the Page File size. Select â€œNo paging 
fileâ€• and hit â€œSetâ€•. Now select the drive that originally had the paging file. Select 
â€œCustom Sizeâ€• and set the Initial Size and the Maximum equal to what you chose to set 



them as when you moved it to the other hard drive/partition. Hit â€œSetâ€• and OK after 
youâ€™re done and reboot when prompted.

7. Notepad tricks.

Open a blank Notepad file 

* Write .LOG as the first line of the file, press enter. 

* Save the file and close it. 

* Double-click the file to open it and notice that Notepad appends the current date and time 
to the end of the file and places the cursor on the line after. 

* Type your notes and then save and close the file. 

Each time you open the file, Notepad repeats the process, appending the time and date to the 
end of the file and placing the cursor below it.

8.  How to get rid of restart now/restart later

found this after a lot of Googling, so I'd like to share the solution. This may not be new or 
even advanced but it surely helped me... 
Anyone who is running Windows XP SP2 knows about this. The most annoying, ill-designed 
dialog box ever invented in the history of the computers that asks "Updating your computer is 
almost complete. You must restart your computer for the updates to take effect. Do you want 
to restart your computer now?" 

And there are only two options: Restart Now/Restart Later. "Restart Later" means that this 
thing will ask you again in 10 minutes. If you're willing to work for the next 4 hours until 
lunch before rebooting, this means you'll need to answer this question 24 times. It also steals 
the focus. 

to get rid of it: 

Start / Run / gpedit.msc / Local Computer Policy / Computer Configuration / Administrative 
Templates / Windows Components / Windows Update / Re-prompt for restart with scheduled 
installations 

You can configure how often it will nag you (I re-configured it for 720 minutes, which means 
I'll be asked twice on a work day), or completely disable it. 

a reboot is needed

9.  Every time give a new email id to ur friends



Now Friends the very first Trick Of Gmail that I Love the most. 
So, it goes like this, say you have a email id mastitrain@gmail.com

If Your Friends wants to send you a mail then they will send it at this email address. 

Now, Let there be three friends of yours, there may be many, just talk about three at present. 
Ram 
Shyam 
Ghanshyam 

If you want to give your friends a unique email id 

For Ram It could be mastitrain+Ram@gmail.com 

For Shyam It could be mastitrain+Shyam@gmail.com 

For Ghanshyam It could be mastitrain+ghanshyam@gmail.com 

So, its simple you could add anything after the initial mail by adding a "+" sign. 

As all these Email Addresses mastitrain+Ram@gmail.com,[email] 
mastitrain+Shyam@gmail.com[/email], & mastitrain+ghanshyam@gmail.com are the same 
as mastitrain@gmail.com

If you have a girlfriend then impress her that how much you love her by showing her name 
mail id. 

Note: This only works when you are sending mails, Not for logging into your account. 

Enjoy.....

10. Activate-windows-xp-without-registration

1. Type Regedit on the Run Menu 

2. Go to Hkey-Local_Machine/Software/ Microsoft/WindowsNT/CurrentVersion/ 
WPAEvents 

3. Select OOBETimer (Reg-Binary) and Press Enter. Now You will See a Set of 12 Keys. 

4. FF D5 71 D6 8B 6A 8D 6F D5 33 93 FD 
{just delete D6 (4th entry) and replace it with C4} 

5. Exit Regedit. 

6. Type "%systemroot%\system32\oobe\msoobe.exe /a" on the Run Menu (without quotes) 

7. Select "Yes I want to telephone a customer service representative to activate windows". 

8. Click Next 



9. Select "Change Product Key" 

10. Put these keys 
QMDGV-QRC2B-XF6JB-GRGHK-W9DRC 

11. Select Update 

Dont worry about asking again to register , close that 

Restart the system and repeat steps 6 to 11, now the process will tell you that Windows XP is 
already activated. 

Thats All.

11. Create-your-own-fonts.

1. Click "Start" 
2. Click "Run" 
3. Type in "eudcedit" 
4. The program that pops up is a hidden font editor that lets you create your own fonts and 
characters to use in other programs like MS Word

12. Speed-up-browsing-folders

You may have noticed that everytime you open my computer to browse folders that there is a 
slight delay. This is because Windows XP automatically searches for network files and printers 
when you open Windows explorer. To stop XP from doing this follow the instructions below. 

Open My Computer 
Click on Tools menu 
Click on Folder Options 
Click on the View tab. 
Uncheck the Automatically search for network folders and printers check box 
Click Apply 
Click Ok 
Reboot your computer 
Try it now, you will see a significant increase in speed.

13. How-to-find-out-password-of-files-via-google

I know how frustrating it is when you download a large file from the net to find out that it is 
locked with 
a password, which you dont have. Cracking the password with softwares like Advanced 
password recovery 
is out of the question bcoz it takes nearly 3 days to guess a 8 character long password. And 
noone can spend that 
kinda time. 



Today I am gonnal post a method to find out passwords for archive files which you 
downloaded from file sharers like -
Rapidshare, Megaupload ......... 

It is pretty easy, fast and doesnt require you to use any software other than a Browser. 

What you need -
1. A browser (preferably Mozilla FireFox) 
2. The file for which you are searching the password must be popular. 

How to do it -

Lets assume that one wants to find password for this file -
http://rapidshare.de/files/5968004/Dead.To.Rights.2-RELOADED.part01.rar.html

In the Google Search toolbar in FireFox copy the name of the file, in this case -
Dead.To.Rights.2-RELOADED.part01.rar 
Or you can manually go to www.google.com and search in the default search box. 

[Note that the full link to sites has been masked in order to preserve board policy] 

By checkin the Actual Url one can see that 
/forum/index.php?showtopic=8927&view=findpost&p=119588 
is a link to a topic in a forum, and hence by clicking on the link, we are taken to a forum 
page. 

The forum is in some other language, but it doesnt matter. On scrolling down the page one 
can see 
the links to the file for which we need the password. And most probably the password will 
posted at the end 
of the link list, 

if it is not posted then you can try the other links or search in other search engines or you can 
even add " " to the keyword and then search. 

Hope this small guide was helpful to you. Now you no longer need to ask others for the 
password to files.

14. Watch-movies-in-ms-paint-kool-trick

Hey guys, did you know that you can REALY watch movies in paint ? 

Here's what you gotta do : 

Open your favorite movie palyer and play the move (I played the .mpg format in Winamp) 

Hit "PrintScreen", keep playing the movie in the player, dont stop it. 



Open MsPaint. 

Select "Edit>Paste" Or Hit "CTRL+V" 

Presto! You can watch movies in Paint! 

But there are no Pause, Next, Previous, Stop etc. buttons 

Spead this fact to all your friends and show how COOL things you can do with Paint! 
Experiment with other formats too, it doesn't play DivX , Flash movies, etc. M*CRO$OFT 
hasn't revealed this i think. MsPaint is GREAT

15. How-to-use-windows-restore-when-windows-wont-start

Use System Restore When Windows Wonâ€™t Start 

When your computer is going haywire, System Restore can be a virtual lifesaver. 
But what if your high-tech troubles are so severe that Windows canâ€™t even start up? In 
that case, try using the Safe Mode with Command Prompt to access System Restore: 

1. After turning on your computer, press the F8 key several times until 
the Windows Advanced Options Menu screen appears. 

2. Use the up or down arrows on your keyboard to select Safe Mode 
with Command Prompt, and then press Enter. 

3. The next screen displays the message, â€œPlease select the operating sys 
tem to start.â€• Assuming you only have Windows XP installed on your 
system, press Enter. If you have more than one operating system 
installed, use the up and down arrow keys to select Windows XP, and 
then press the Enter key. 

4. Windows loads some software, which could take a minute or two. 
Depending on how your version of Windows is configured, a login 
screen or the Welcome Screen appears. If you see the login screen, 
type your account name and password (if you have one), press Enter. 
If you see the Welcome Screen, click the icon for the account labeled 
Administrator or an account that has administrative privileges, and 
then type your password (if you have one). 

5. Next, a command prompt appears. Type %systemroot%\system32\restore\rstrui.exe in 
the blank, and then press the Enter key. 

6. After several seconds, the System Restore window appears. Click the 
Restore My Computer to an Earlier Time button. 

7. Click the Next button, located near the lower-right corner of this 
window. 

8. A calendar appears. In it, click a day when your computer was 
working properly, and then click the Next button. 



9. To confirm your choice, click Next. 

10. The System Restore process begins. Moments later, your computer 
automatically restarts itself. When it boots up, follow the on-screen 
instructions.

16. useful-tipsseful-tips

1-Increasing System Performance 

If you have 512 megs or more of memory, you can increase system performance 
by having the core system kept in memory. 

1. Start Regedit 
2. Go to HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Contro l\Session 
Manager\Memory Management\DisablePagingExecutive 
3. Set the value to be 1 
4. Reboot the computer 

2-Removing the MSN Messenger 

If you want to remove the MSN Messenger from always starting in the system tray, do 

1. Start / Run 
2. Then enter in the following string: RunDll32 advpack.dll,LaunchINFSection 
%windir%\INF\msmsgs.inf,BLC.Remove 

To remove it completely, see the section Adding / Removing Additional Programs 

Remove the hide from the line: 
msmsgs=msgrocm.dll,OcEntry,msmsgs.inf,hide,7 

3-Common Command Console Utilities 

WindowsXP comes with quite a few console utilities you can easily run from the command 
line: 

Computer Management - compmgmt.msc 
Disk Managment - diskmgmt.msc 
Device Manager - devmgmt.msc 
Disk Defrag - dfrg.msc 
Event Viewer - eventvwr.msc 
Shared Folders - fsmgmt.msc 



Group Policies - gpedit.msc 
Local Users and Groups - lusrmgr.msc 
Performance Monitor - perfmon.msc 
Resultant Set of Policies - rsop.msc 
Local Security Settings - secpol.msc 
Services - services.msc 
Component Services - comexp.msc 

4- Hide/Unhide Logon Names 

If you want to hide or unhide the names of users that are displayed on the initial logon 
screen: 

1. Start Regedit 
2. Go to HKEY_LOCAL_MACHINE \ SOFTWARE \ Microsoft \ Windows NT \ CurrentVersion \
Winlogon \ SpecialAccounts \ UserList 
3. Add a DWORD with the name of the user account you want to hide 
4. Make sure it has a value of 0 
5. If there is an existing account, you can unhide it by giving it a value of 1 

5- Renaming the Start Button 

To rename the start button, you will need a hex editor. 
My preference is UltraEdit 

1. Copy the \windows\explore.exe file to a new name (e.g. explorer_1.exe) 
2. With the hex editor, open that file and go to offset 412b6 
3. You will see the word start with blanks between each letter 
4. Edit it be any 5 characters or less 
5. Save the file 
6. Boot to DOS 
7. Copy the existing c:\windows\explorer.exe to explorer.org 
8. Copy explorer_1.exe to explorer.exe 
9. You will also need to replace the explorer.exe in the c:\windows\system32\dllcache file as 
well with the new one. 

Note: If the partition is NTFS and you can't access the files from DOS: 

1. Start Regedit 
2. Go to HKEY_LOCAL_MACHINE \ SOFTWARE \ Microsoft \ Windows NT \ CurrentVersion \
Winlogon. 
3. Change the value of Shell from Explorer.exe to explorer_1.exe.

17.  Speed-up-the-start-menu-in-windows-xp

The Start Menu take a quite a while to display the list of programs installed. In order to get 
Windows XP to display the list faster, you will have to edit some registry settings. Remember 
to back up your regitry before making any changes. 

To speed up, goto Start > Run and type regedit. This will open the registry window. Then 
navigate to the following key: HKEY_CURRENT_USER\Control Panel\Desktop. Scroll down in 
the Right panel and double click on "menushowdelay". In the Value Data box, change the



default value for the menu speed from 400 to a lesser number, such as 1 or even 0. Click OK 
You should now find a significant increase in the startmenu speed

18.  clear-pagefile-on-shutdown

     For added security you should always clear the page file upon shutting down your computer. 
Windows uses this file as extra ram. Lets say that you are working on a confidential MS Word 
doc. 

When you load this document it is loaded into ram. To save ram windows places certain items in 
the page file. The page file can then be opened and the document can be extracted as well as any 
other open program or files. However Microsoft has implemented a feature that will clear the 
page file but they do not have it enabled by default. 

Please note, this will slightly increase the amount of time it takes to shut down your computer 
but it is well worth it. 

Start Regedit. If you are unfamiliar with regedit please refer to our FAQ on how to get started. 

Navigate to HKEY_LOCAL_MACHINESYSTEMCurrentControlSetControlSession ManagerMemory 
Management 

Select ClearPageFileAtShutdown from the list on the right. 
Right on it and select Modify. 
Change the value to 1 to enable. 
Reboot your computer.

19. Microsoft Windows amazing facts............too good

MAGIC #1

An Indian discovered that nobody can create a FOLDER anywhere on the computer which can be 
named as "CON". This is something pretty cool...and unbelievable. .. At Microsoft the whole 
Team, couldn't answer why this happened! 
TRY IT NOW ,IT WILL NOT CREATE " CON " FOLDER

MAGIC #2
For those of you using Windows, do the following: 

1.) Open an empty notepad file 
2.) Type "Bush hid the facts" (without the quotes) 
3.) Save it as whatever you want. 
4.) Close it, and re-open it. 

is it just a really weird bug? Confused? 

MAGIC #3
microsoft crazy facts 

This is something pretty cool and neat...and unbelievable. .. At Microsoft the whole Team, 



including Bill Gates, couldn't answer why this happened! 

It was discovered by a Brazilian. Try it out yourself... 

Open Microsoft Word and type 

=rand (200, 99) 

And then press ENTER

20. Auto Shutdown Pc without using any external program.......

METHOD # 1 

Do you know that you can make your PC shutdown at a time u wish to? 
Here is the trick!! 
How To Make A Shutdown Timer! 

Step 1: 

Right click on your desktop and choose "New=>shortcuts". 

Step 2: 

In the box that says "Type the location of the shortcut", 
type in "shutdown -s -t 3600" without the quotation marks and click next. 

Note: 3600 are the amount of seconds before your computer shuts down. So , 
60secs*60mins=3600secs. 

Step 3: 

Make up a name for the shortcut and you're done. 
You can change the icon by right clicking=>properities=>change icon=>browse. 

To abort: 

To make an abort key to stop the shutdown timer just create another shortcut and make 
the "location of the shortcut" to " shutdown -a" without the quotes. 

METHOD # 2 

Here is another trick to shutdown at a specific time, for example you wish to shutdown at 
11:35am. Type this in 
start=>Run 

Type Code: at 11:35 shutdown -s 



to abort 

Code: 

shutdown -a 

take note: all time are in 24hr, example u would like to shutdown at 8:30pm, you should type 

"at 20:30 shutdown -s" without quote 

METHOD # 3 

you can use a batch for that as well it makes it easier to use 
just run the batch and enter the time you want it to shutdown 

shutdown.bat 
Type Code: 
@echo off 
title Scheduled Shutdown Batch Example by chacha1234 
color A 
echo Enter Time To Shutdown (example 19:30) 
set /p stime=
cls 
at %stime% ""shutdown -s -t 00"" >nul 
echo Your PC Will Auto Shutdown At %stime% 
echo Press Any Key To Exit 
pause >nul 
exit 

also you can add -c "desired message" at the end of the shutdown command 
for example 
shutdown -s -t 60 -c "Shutdown Pc" 

using this command u can also schedule ur pc to restart 
for example 
shutdown -r -t 60 -c "Restarting Pc"

21.   20 Top Ways to Speed up your PC

--------------------------------------------------------------------------------

Follow these tips and you will definitely have a much faster and more reliable PC! The icon means 
the tip will probably work best under Win98. 



1. Wallpapers: They slow your whole system down, so if you're willing to compromise, have a 
basic plain one instead! 

--------------------------------------------------------------------------------

2. Drivers: Update your hardware drivers as frequently as possible. New drivers tend to increase 
system speed especially in the case of graphics cards, their drivers are updated by the 
manufacturer very frequently! 

--------------------------------------------------------------------------------

3. Minimizing: If you want to use several programs at the same time then minimize those you are 
not using. This helps reduce the overload on RAM. 

--------------------------------------------------------------------------------

4. Boot Faster: The 'starting Windows 95/98' message on startup can delay your booting for a 
couple of seconds. To get rid of this message go to c:\ and find the file Msdos.sys. Remove the 
Read-Only option. Next, open it in Notepad or any other text editor. Finally, go to the text 
'Options' within the file and make the following changes: Add BootDelay=0. To make your 
booting even faster, set add Logo=0 to remove the Windows logo at startup. 

--------------------------------------------------------------------------------

5. Restart only Windows: When restarting your PC, hold down Shift to only restart Windows 
rather than the whole system which will only take a fraction of the time. 

--------------------------------------------------------------------------------

6. Turn Off Animations: Go to Display Settings from the Control Panel and switch to the Effects 
Tab. Now turn off Show Windows Content While Dragging and Smooth Edges on Screen Fonts. 

--------------------------------------------------------------------------------

7. Faster Start-Menu Access: Go to the Start menu and select Run. Now type Regedit and hit 
Enter. The Registry Editor will appear on the screen. Now, open the folder 
HKEY_CURRENT_USER\Control Panel\Desktop. You should see a MenuShowDelay value. If you 
don't then do the following: right click on a blank space in the right pane and select New\String. 
Change the name in the new value to MenuShowDelay. Now that we have the MenuShowDelay 
value, double click on it and enter 0 in the value data field. This sets the start menu delay to 0 
milliseconds. 

--------------------------------------------------------------------------------



8. Resolutions: If you are willing to do anything for faster performance from your PC, then try 
lowering your display resolution. The lower it is, the faster your PC. 

--------------------------------------------------------------------------------

9. Turn off Active Desktop: Go to your Display Properties and switch to the Web tab. Uncheck 
View My Active Desktop As a Web Page. Since the Active Desktop option under Windows 98 uses 
a lot of system resources, this option can have a dramatic effect on the speed of the whole 
system. 

--------------------------------------------------------------------------------

10. Defragment Often: Windows 98's Defrag tool uses Application Acceleration from Intel which 
means that when you defragment your drive, data is physically arranged on the drive so that 
applications will load faster. 

--------------------------------------------------------------------------------

11. Take your PC to Bed: Using the Advanced Power Management feature under Windows 98 
gives you the option to use the sleep command. That way, you can send your PC to sleep instead 
of shutting it down and then restarting it. It's as simple as pressing a button and then pressing 
the same button to wake it up. You can tell Windows after how many minutes/hours of inactivity 
to automatically sleep the machine in the Advanced Power Management section of the Control 
Panel. 

--------------------------------------------------------------------------------

12. Faster Internet Access: If you use the internet for reference and the sites you visit are rarely 
updated then try the following. In IE (the same can be done in Netscape) go to Tools, Internet 
Options. Next, click on Settings... in the Temporary Internet Files section. Finally, select Never 
for the first option and double the amount of storage space to use, click OK! 

--------------------------------------------------------------------------------

13. Benchmarking: Benchmarking can be very useful when run frequently. It can tell you how 
your PC's components are performing and then compare them to other machines like yours. For 
example, when you overclock your PC, you want to know how much more speed you have and 
whether it is stable. All this and more can be discovered using benchmarking. An excellent piece 
of software for doing this job is SiSoft Sandra which can be found in the Downloads File Archive! 

--------------------------------------------------------------------------------

14. Refresh the Taskbar without restarting: If you in some way change the taskbar, either in 
Regedit or elsewhere, you can refresh the task bar without restarting. Hold down Ctrl Alt Del, and 
double click on Explorer. Say Yes to close Explorer, but no to closing Windows. This will refresh 
the Taskbar and system tray. 



--------------------------------------------------------------------------------

15. Quick CD Eject: Instead of pushing the button on your drive, right-click your CD drive letter 
in My Computer and click on Eject. This will also remove any icons that have become associated 
with the CD drive. 

--------------------------------------------------------------------------------

16. Start Up Programs: Windows can be slowed down when programs run on start up. To 
eliminate this, check your Start up folder. You can access it from the start menu: Start, 
Programs, Start Up. Another way to eliminate programs from loading even before Windows 
actually starts is by doing the following: Click on Start, then Run. Type msconfig. It will take 
quite a long time for this program to load, but when you finally see it on your screen, explore the 
different tabs. They all have to do with how quickly your PC boots, so select what you want, and 
uncheck what you don't want! 

--------------------------------------------------------------------------------

17. Fonts: When Windows starts, it loads every single font in the Fonts folder. Therefore, the 
more fonts you have, the slower the booting process. To get rid of unwanted fonts, simply go to 
the Fonts folder under c:\windows and remove whatever you don't want. Fonts that have a red 
letter 'A' as their icon are system fonts, so don't delete them. 

--------------------------------------------------------------------------------

18. Stretching Wallpapers: Don't "stretch" your wallpaper in Windows 98 since it actually slows 
Windows down when you drag icons around on the desktop. 

--------------------------------------------------------------------------------

19. RAM Matters: If you have less than 32MB then you should seriously think of upgrading it to at 
least 64MB. Windows runs much more smoothly with 64MB or higher and tends to use less hard 
disk space for virtual memory. 

--------------------------------------------------------------------------------

20. Partitioning: A very nice little thing you can do to boost system performance. By partitioning 
your hard drive, splitting one physical drive into several logical ones, you can gain several 
advantages. 1. If you get a virus or you accidentally format a drive, not all will be lost. 2. By 
placing the swap file (Win386.swp) on a separate drive, The swap file will be less fragmented and 
thus, faster. 3. Place Windows on a separate drive and whenever you need to reinstall it, you rest 
assured that your data is safe on a separate drive. Partitioning can be done using a few programs 
such as FDisk which comes with DOS. However, FDisk formats everything on the hard disk before 
partitioning. Alternatively, you can use Partition Magic from Power Quest to partition your hard 
disk without losing your data.



22.  U can lock any folder without any softwares.

 Using the codes given below u can redirect the folder to control panel, internet explorer etc., by 
renaming the files by pasting the code for example if u have a folder in d: which is named as 
"HELL" then rename it to Control Panel.{21EC2020-3AEA-1069-A2DD-08002B30309D}. thats all 
ur folder will redirect to control panel. 

Control Panel.{21EC2020-3AEA-1069-A2DD-08002B30309D} 
Internet Explorer.{FBF23B42-E3F0-101B-8488-00AA003E56F8} 
Recycle Bin.{645FF040-5081-101B-9F08-00AA002F954E} 
My Computer.{20D04FE0-3AEA-1069-A2D8-08002B30309D} 
My Documents.{ECF03A32-103D-11d2-854D-006008059367} 
Fonts.{BD84B380-8CA2-1069-AB1D-08000948F534} 

to unlock the folder 
Go to Start>RUN>CMD 
If the folder is in d: then go to that drive 
then type dir/x then the folder is shown as for example with control panel it shows as 
contro~1.{21 
rename this folder to any name using command "ren control~1.{21 myfolder" without quote ok 
that it all over..... U can lock and unlock the folder

23. Disable-windows-error-reporting-messages

You must be well aware of Error Messages that come up whenever there is a problem with 
windows or any other component. Actually this service is by Microsoft that allows you to send a
Error report of the problem so that they can fix it in the coming versions. However, sometimes 
this service can really irritate you. 

Well, you donÃ¢â‚¬â„¢t need to get angry any more, you can disable it with few clicks. Just 
follow these steps. 

1 Go to My computer Ã¢â‚¬â€œ> Properties Ã¢â‚¬â€œ> Advanced. 
2 In this tab click on Error Reporting button down below. 
3 Choose Disable Error reporting from there. 



ThatÃ¢â‚¬â„¢s all. You are now free of those error messages 

24. Using-my-computer-as-a-toolbar

If you click and drag your 'my computer' icon to the right side of the taskbar, just left of the light 
blue area, you will create a my computer taskbar. This opens into a start menu-style cascading 
menu that will allow you to easily access any file in your system.

25. Set-your-favourite-video-as-wallpaper

This is a pretty simple tweak using which you can set any video as your desktop wallpaper. 

Just follow the steps given below: 

1.Download VLC Media Player and install it. 

2.Run VLC media player,go to Settings->preferences->Interface->Main interfaces,then click on 
wxWidgets.Remove the tick on "Taskbar" and put a tick on "Systray icon". 

3.Now go to Video->Output Modules->DirectX.On the bottom right put a tick on advanced 
options check box.You will now see some options.Put a tick on "Enable Wallpaper Mode ". 

4.Now,select playlist and put a check or tick on "Repeat current item ". 

5.Press the Save button.Now close the Vlc player and run it again(to save the settings 
permanently). 

6.Now play any video you would like to set as Wallpaper.Right click on the video and click on 
"Wallpaper".The video would be set as your wallpaper!!!! 

Since you have checked the option "repeat current item ",the selected video will play on 
continuously.It will start again when finished.VLC player will remain in your system tray.If you 



wish to remove the wallpaper simply close the player and you will get back your original 
wallpaper.

26. How-to-backup-windows-xp

 Learn how to backup your Windows XP computer quickly. This is a down and dirty full system 
backup. This will allow you to restore everything on your system if you had a system crash. 
Steps 

1. Click Start -> Run -> type in, with out the quotes, "ntbackup.exe". 
2. Click on Backup Wizard and then "Next". 
3. Select the radio button "Backup everything on this computer" and click "Next". 
4. Choose a location where you will save your backup. 
5. Type in a name of your backup that you will recognize and click "Next". 
6. Click "Finish" and your backup will begin. 
7. It will complete and provide you a report of the backup. 
8. Click "Close" and your backup is complete. 

Tips 

* Make sure the location you are backing up to has enough storage space to backup your entire 
computer. 
* You will have to be certain you won't have to turn off your computer during the backup. 
* Full System backups can take extended amounts of time depending on how much data you 
have to backup so be prepared.

27. Windows Performance angel

Cleaning the TEMP Directory 

One thing that is often overlooked, and can have a negative affect on your computer's 
performance, 
are all the files that are in the TEMP directory. I've had quite a few people ready to get new 
computers until this was cleaned. 
These are easy to clean and slightly different in Win9x and Windows2000 or WindowsXP 

Windows98 

Open up a DOS prompt 

CD \windows\temp (make sure you are in that directory before running the next line. 

Run deltree /y *.* 

CD \windows 

Run del *.tmp (be very careful of the spelling) 

Windows2000 / WindowsXP 



Go to C:\Documents and Settings\User_Name\Local Settings\Temp (where User_Name is 
replaced by the person who is logged in) 

Delete all the files

28. Faster-xp-

      1) Increasing-file-system-caching

To increase the amount of memory Windows will locked for I/O operations: 

Start Regedit 
Go to HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Session Manager\Memory 
Management 
Edit the key IoPageLockLimit

   2) increasing-system-performance

If you have 512 megs or more of memory, you can increase system performance 
by having the core system kept in memory. 

Start Regedit 
Go to HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Session Manager\Memory 
Management\DisablePagingExecutive 
Set the value to be 1 
Reboot the computer

   3) -decreasing-boot-time

Microsoft has made available a program to analyze and decrease the time it takes to boot to 
WindowsXP 
The program is called BootVis 

Uncompress the file. 
Run BOOTVIS.EXE 
For a starting point, run Trace / Next Boot + Driver Delays 
This will reboot your computer and provide a benchmark 
After the reboot, BootVis will take a minute or two to show graphs of your system startup. 
Note how much time it takes for your system to load (click on the red vertical line) 
Then run Trace / Optimize System 
Re-Run the Next Boot + Drive Delays 
Note how much the time has decreased 
Mine went from approximately 33 to 25 seconds.

  4) speeding-the-startup-of-some-cd-burner-programs

If you use program other than the native WindowsXP CD Burner software, 
you might be able to increase the speed that it loads. 

Go to Control Panel / Administrative Tools / Services 
Double-click on IMAPI CD-Burning COM Service 



For the Startup Type, select Disabled 
Click on the OK button and then close the Services window 
If you dont You should notice

29. Making your windows folder smaller

Why would I want to do this? 

There are many reasons for making your windows folder smaller, first it saves space and 
removes windows features you will probably never use that are just slowing down your computer. 

What can you delete? 

That is what this article is about, I will explain everything I know is safe to delete, and what 
happens if you do! 

Will this really improve the speed of my system? 

I donÃ¢â‚¬â„¢t have any results to prove it, but I think it does improve boot time a little, and 
after a clean install, it does seem to make the system slightly faster after deleting these things. 

Final notes: This has been tested on Windows XP Pro Final and SP1 (Not home, but it should work 
fine) Windows 2003 Enterprise Server 3700, RTM, and The Free Evaluation version (Any 2k3 
version should work fine), and Windows 2000 Pro. If the following folders are not on your 2k/2k3 
system it means they are only in XP and you donÃ¢â‚¬â„¢t need to worry about them. 

If for some reason you can not delete a folder, just delete the files inside, I tried to make not of 
the folders that cant be deleted, but depending on your system and if you use FAT32 or NTFS it 
may be different. 

All of the paths listed in there are C:\Windows and C:\Program Files, if your folders have different 
names (Like C:\WINNT on windows 2k) then you should use that path instead. 

Well, lets get started deleting, these start out ordered from largest to smallest, but after the first 
few files they are all fairly small, and are just in a random order. 

1. c:\windows\system32\dllcache\

NOTE: DONÃ¢â‚¬â„¢T DELETE THIS FOLDER, JUST ALL THE FILES INSIDE! This folder uses a LOT 
of hard drive space, it holds a backup of every system file that windows uses. Deleting this will 
cause a SFC error when you replace a system file instead of windows putting back the original 
file. For people who want to mod there system, this is a good thing. 

2. c:\windows\servicepackfiles\i386\

NOTE: DONÃ¢â‚¬â„¢T DELETE THIS FOLDER, JUST ALL THE FILES INSIDE! This folder only exists 
if you installed a service pack on XP, if you did a slipstream it wonÃ¢â‚¬â„¢t be here either. This 
folder is the same as the dllcache, but has the new files that were updated by a service pack. If 
you delete the dllcache, deleting this is just like finishing the job. 



3. c:\windows\$Uninstall----$ 

These $uninstall----$ folders are used whenever you want to uninstall a windows update. If you 
delete them, you can not uninstall the update(s), but if the updates are working fine for you, 
there should be now reason to remove them. 

4. c:\windows\cursors\

This folder contains some custom cursers for windows, if you are happy with the default cursers, 
or use your own set like Blue Curve, then deleting this wont effect you at all. 

5. c:\windows\driver cache\i386\

NOTE: DONÃ¢â‚¬â„¢T DELETE THIS FOLDER, JUST ALL THE FILES INSIDE! This is one you may 
not want to delete, this takes up a bit of space (about 80mb) but windows uses if you ever add or 
remove windows components and things like printer drivers. If youÃ¢â‚¬â„¢re your hardware is 
already working fine, you donÃ¢â‚¬â„¢t need this folder on your hard drive. For example, if you 
delete this folder, and try to install IIS, windows will ask for the CD or Network share with the 
files on it, if you donÃ¢â‚¬â„¢t need to add or remove windows components often, deleting this 
will free up some space for you. 

6. c:\windows\help\

NOTE: DONÃ¢â‚¬â„¢T DELETE THIS FOLDER, JUST ALL THE FILES IN SIDE! This folder contains 
all of the windows help files. If you are like me, and think they having 50mb of help files is a 
waste, then you probably want to delete it. If you delete this folder and try to view a help file, the 
Help and Support center will come up with a 404 error. No harm is done, you just canÃ¢â‚¬â„¢t 
view the help files (because you deleted themÃ¢â‚¬Â¦). There is also a tours folder inside of the 
help folder, you can delete everything in this folder also, but windows wonÃ¢â‚¬â„¢t let you 
remove the actual folder. 

7. c:\windows\inf\

NOTE: DONÃ¢â‚¬â„¢T DELETE THIS FOLDER, JUST ALL THE FILES INSIDE! This folder contains a 
lot of windows drivers, if you ever add new hardware, windows looks in this folder, then on your 
CD drive for the latest drivers. Any hardware you might get will probably come with the drivers 
on a disk, so this folder is just a wasting space on your hard drive with outdated drivers. If all of 
your hardware is working fine, and you donÃ¢â‚¬â„¢t plan on adding any new hardware for a 
while, deleting this wont effect your system at all. If you donÃ¢â‚¬â„¢t want to delete everything 
in it, you can go into the folder, press CRTL+F and search for mdm*.* and delete everything that 
comes up. These are all modem drivers, and it is very unlikely you will ever need them because 
you either have a modem installed already, or if you do add one, it will come with newer drivers. 

8. c:\windows\srchasst 

This folder is the XP Search assistant, if you delete it, windows will just use the classic 2k style 
search instead, which is more functional and easier to use. 

9. c:\windows\downloaded installations\

This folder holds the installers for some programs you download and install, for example, Tweak 
UI puts its installer in this folder, and so you can repair it or update its components later. 
Deleting this folder wonÃ¢â‚¬â„¢t harm any programs I have ever seen, but you should look 



inside this and see what you are deleting first. 

10. c:\windows\media\

These are the default windows sounds, if you donÃ¢â‚¬â„¢t want them, deleting them wont hurt 
anything. 

11. c:\windows\system32\restore\

This is the system restore apps, if you delete this, system restore will no longer work. Before you 
delete this, you should go into System Restore, and delete all your restore points, and then you 
should go to the system properties and disable system restore. After that, you can delete this 
folder, and not worry about system restore slowing down your system or sucking up space. 

12. c:\windows\system32\usmt\

This folder is the File and Settings Transfer wizard. If you have no need for it, then deleting this 
wont have any other effects besides the File and Settings Transfer wizard not working anymore. 

13 A. c:\program files\msn 
13 B. c:\program files\netmeeting\

These are the MSN Explorer and Net Meeting applications. If you donÃ¢â‚¬â„¢t need or use 
them, then you can delete these folders (For net meeting, you can only delete the files inside) 
and the only thing it will effect is that these programs will know longer work. 

14. C:\windows\system32\oobe

NOTE: DONÃ¢â‚¬â„¢T DELETE THIS FOLDER, JUST ALL THE FILES INSIDE! In this folder is the 
Out of Box Experience (The screens you see right after you have installed XP for the first time), 
and the XP Product Activation stuff. If you have a Retail or OEM version of XP, and you think you 
might ever need to activate again, DONÃ¢â‚¬â„¢T DELETE THIS. So unless you are using XP or 
2k3 CORP, you may still need this folder someday. 

15. c:\windows\msagent 

This folder holds the MS Agent program. The MS Agent is a gay little wizard thing that looks like 
the Office Assistant, I personally hate this thing, and removing it will get rid of it for good! If 
windows wont let you remove the folder, just delete everything inside of it, and everything inside 
of the intl folder. 

16. c:\windows\java 

This is the crappy MS Java components that donÃ¢â‚¬â„¢t work well, and MS got sued over. If 
you have Windows XP slipstreamed with SP1a you wont have this because MS no longer 
distributes it. If you use websites that use Java Applets, you should keep this, or remove it and 
install Suns Java VM. 

17. c:\windows\mui 

This is a little app that allows you to switch between multiple languages, if you only use one 
language, then deleting this wont effect you at all. NOTE: I think this folder only exists on XP Pro 
because Home Edition doesnÃ¢â‚¬â„¢t support multiple languages. 



Post Deletion: 

After you have deleted everything you want to, I recommend you run the Regisrty Cleaner.This 
will remove all the references to things you deleted so a window doesnÃ¢â‚¬â„¢t look for the files 
any more. If you delete the Java Folder, RegCleaner will find at least 50 reg entries related to it, 
and can remove them for you if you want. 

What else can I do to make the windows folder smaller? 

If you want to make your windows folder even smaller, and you use NTFS, you can use NTFS 
compression to make the windows folder smaller. Although you can compress everything it, 
compressing EXEs and DLL files will make you system a little bit slower, so I recommend 
compressing everything BUT EXE and DLL files. 

Using this guide, you should easily be able to make your windows folder less then 1gb, but 
because some programs add there own files to the windows dir, your results may differ from 
what other people have gotten there folder sizes to. After a clean install, it is fairly easy to get 
your windows folder less then 700mb so you can put a image file of your clean install on one CD 
and be able to restore it easily.

30. Remove "unremovable" Desktop Icons

1. Run Regedit by going to Start>Run and typing "Regedit" 

2. Go to 
HKEY_LOCAL_MACHINE\SOFTWARE\Mcft\Windows\CurrentVersion\Explorer\Desktop\NameSpace 
For some reason the word M i c r o s o f t is shortened to Mcft 

3. Here you will see a list of various icons. They are not listed by name but by CLSID. 

4. To remove an icon from your desktop, simply delete the key and hit F5 to refresh your 
desktop. 

{645FF040-5081-101B-9F08-00AA002F954E} - Recycle Bin. 
{20D04FE0-3AEA-1069-A2D8-08002B30309D} - My Computer.
{208D2C60-3AEA-1069-A2D7-08002B30309D} - My Network Places. 

WARNING: Regedit has no mercy. It is very dangerious to mess around in. Note there is no 
Edit>Undo. If you make a mistake it could mean you'll be reinstalling your OS!

31. Shutdown-xp-faster

Like previous versions of windows, it takes long time to restart or shutdown windows XP when 
the "Exit Windows" sound is enabled. To solve this problem you must disable this useless sound. 
ÃƒÆ’Ã‚Â¢ÃƒÂ¢Ã¢â‚¬Å¡Ã‚Â¬Ãƒâ€šÃ‚Â¢ Click Start button. 
ÃƒÆ’Ã‚Â¢ÃƒÂ¢Ã¢â‚¬Å¡Ã‚Â¬Ãƒâ€šÃ‚Â¢ Go to settings > Control Panel > Sound, Speech and Audio 
devices > Sounds and Audio Devices > Sounds. 
ÃƒÆ’Ã‚Â¢ÃƒÂ¢Ã¢â‚¬Å¡Ã‚Â¬Ãƒâ€šÃ‚Â¢ Then under program events and windows menu click on 
"Exit Windows" sub-menu and highlight it. Now from sounds you can select, choose "none" and 
then click Apply and OK. 
Now you should see some improvements when shutting down your system.



32. How-to-easily-restart-windows-xp

You can restart a Windows XP Pro and Home machine easily by creating a shortcut with following 
path. (Assume you installed Windows XP on your C: Partition) 
"c:\windows\system32\shutdown.exe -r -f -t 00" -r is for restarting the computer. -f is to force 
close all programs without saving. -t 00 is used to restart in zero seconds. i.e. as soon as you 
D.Click on the shortcut. You can log off from a Windows XP Professional or Home edition by 
running "C:\windows\system32\shutdown.exe -l -f -t 00". Also you can shutdown a Windows XP 
Home or Professional edition by running "c:\windows\system32\shutdown.exe -s -f -t 00". You 
always have to turn from the CPU after running this command. (Same with AT and ATX powered 
machines.) If you want to turn down power of ATX machine automatically, run 
"c:\windows\system32\tsshutdn.exe 00 /POWERDOWN /DELAY:00" This is used to turn off a 
server. Even though your computer will be shutdown completely, this whole operation will take 
30 seconds to finish. Even though you don't have networked computers attached to your 
computer, this works.

33. Tips to recover scratched CDs

Don't you feel like crying every time you add another disc to your pile of scratched discs. 
Trashing that disc which contained your favorite songs, pics, files, games or videos is not easy. 
Read-on, if you find yourself wishing for a miracle every time your fav CD is scratched 

Home Remedy :
here's an easy home remedy, which might give you the desired results. Rub a small amount of 
toothpaste on the scratch and polish the CD with a soft cloth and any petroleum-based polishing 
solution (like clear shoe polish). Squirt a drop of Brasso and wipe it with a clean cloth.

34. To convert a FAT partition to NTFS:

Click Start, click Programs, and then click Command Prompt. 
In Windows XP, click Start, click Run, type cmd and then click OK. 
At the command prompt, type CONVERT [driveletter]: /FS:NTFS. 
Convert.exe will attempt to convert the partition to NTFS. 

NOTE: Although the chance of corruption or data loss during the conversion from FAT to NTFS is 
minimal, it is best to perform a full backup of the data on the drive that it is to be converted prior 
to executing the convert command. It is also recommended to verify the integrity of the backup 
before proceeding, as well as to run RDISK and update the emergency repair disk (ERD).

35. Removing Multiple Boot Screens:

If you are getting unwanted multiple boot screen 
Then Follow these Steps. 

1> Right Click on My Computer 

2>Select Properties 

3>Select Advanced Tab 



4>Select Settings In the Startup & Recovery Section(3rd grp) 

5>Select the operating system which u want. 

6>And Click OK. 

7>Further again press the setting and click on Edit. 

8>It will open boot.ini File. 

9>Now u can delete those o/s which you don't want to be displayed. 

Note: For deleting operating systems from boot.ini file, keep it mind that you can't 
delete that o/s which is selected by default there. Before 
making any changes make a copy of boot.ini file.

36. Some problems in system

1. MONITOR LED IS BLINKING 
Check all the connections like Monitor Cable, Data cables,RAM, Display Card , CPU 
connections. 

2. CONTINUOS THREE BEEPS 
Problem in RAM Connection. 

3. THREE BEEPS ( 1 Long 2 Short) 
Problem in Display Card Connection 

4. THREE LONG BEEPS PERIOD WISE 
Problem in BIOS or RAM (Basic Input Output System) 

5. CONTINUOS NON-STOP BEEPING 
Key Board Problem (I.e.; Some Key is pressed for Longer time) 

6. FDD LED IS GLOWING CONTINUOSLY 
Data cable to be connected properly (twisted cable). 

7. NO DISPLAY ON THE SCREEN AT ALL 
Hard Disk cable connected wrongly. Connect rightly seeing the Red mark (Faces power 
supply) and then Restart. 

8. POWER LED IS OFF 
a. Check main power cord 
b. Check S.M.P.S. 
c. Check Mother Board connection 

9. SHOWING CMOS ERROR 
Replace 3 Volt battery of Mother Board . Set Original Settings Manually.(Refer CMOS Setup 
chart) 
Enter your search termsSubmit search form 

10. SHOWING FDD ERROR OR FLOPPY DRIVE IS NOT WORKING PROPERLY 



Check Power cord of FDD , Data Cables , set CMOS & Finally the Check drive. 

11. SHOWING HDD ERROR OR HARD DISK FAILURE 
a. Check Power Cord 
b. Check connection of HDD 
c. Check Data cable 
d. Check Hard Disk parameters in CMOS or Auto detecting Setting Partitions by Fdisk 
Command, then format it to set track 0. 

12. MOTHER BOARD HANGS DUE TO UNSTABILIZED POWER SUPPLY 
a. Check S.M.P.S 
b. RAM not functioning properly. 
c. Software problem (due to using pirated software) 
d. CPU fan not functioning properly. 

13. DANCING SCREEN 
a. Check Display card connection 
b. Virus Problem 
c. Video Memory Problem 

14. SHAKING SCREEN 
a. Earthing problem 
b. Magnetic waves comes around. 

15. CPU CABINET SHOCK 
a. Check Earthing 
b. Check main power cord. 

16. NON-SYSTEM DISK ERROR 
a. Floppy Drive having different disk (Non-Bootable Disk) OR CMOS Parameters for Hard Disk 
may not be set properly. 
b. Hard Disk Partitions may not be created. 
c. Hard Disk may not be formatted. 

7. MISSING OPERATING SYSTEM 
The System files missing namely Ie; command.com} - User File IO.SYS & MS_DOS.SYS } -
Hidden Files. These above three files required for Start up of the system that can be 
transferred by using SYS C: Command OR While the time of formatting by using Format 
c:/u/s 

18. MISSING COMMAND INTERPRETOR 
May the file Command.com is corrupted OR Infected by Virus OR Some one has Erased it. 

19. SHOWING I/O ERROR 
a. The type of Hard Disk in CMOS may not be set properly. 
b. Operating system used for formatting is not valid 

20. SHOWING DIVIDE OVER- FLOW MESSAGE
a. May some Directories or Files crash with other files. 
b. Use CHKDSK/F or SCANDISK Command to correct it. 

21. HARD DISK MAKING NOISE WHILE PROCESSING 



a. Unstabilized power supply. 
b. Check for Loose Contact. 
c. Do not use Y Connectors for Hard Disk. 
d. It may create Bad Sector OR Weak Hard Disk. 

22. HARD DISK HANGS WHILE PROCESSING 
Check for Bad Sector by using CHKDSK or SCANDISK Command. If found format the Hard 
Disk and set Partition before that area.(This is the only procedure to use Hard Disk with Bad 
Sector) OR (To avoid Bad Sectors use Standard Power Supply) 

23. HARD DISK NOT DETECTED 
a. Check Power Connector 
b. Check Data Cables 
c. Check Jumpers 

24. PARTITION NOT SHOWN 
Operating System where the Hard Disk formatted is not supported with present Mother Board. 
For Eg: Hard Disk formatted with Pentium System will hide their partitions for 486 System. 

25. MMX/DLL FILE MISSING 
May the above files may be corrupted due to power failure or Virus. Make available above files 
from other Computer. OR Reinstall Windows 98 Operating System. (This procedure will not 
make any effect on existing Data). 

26. WINDOWS REGISTRY ERROR 
This will happen due to sudden ON/OFF of the system. Final solution is to Reinstall Operating 
System. 

27. DISPLAY COLOUR DOES NOT MATCH 
a. Configure Display Card properly with their CD. 
b. The Standard setting for Windows is set it to 800x600 for better performance. 

28. UNKNOWN DEVICE FOUND 
May the Driver utility is not provided with operating system . Insert Driver CD and install 
software for the above Device. (Every Device requires driver utility to set active)

37. 100 keyboard shortcuts

CTRL+C (Copy) 

CTRL+X (Cut) 

CTRL+V (Paste) 

CTRL+Z (Undo) 

DELETE (Delete) 

SHIFT+DELETE (Delete the selected item permanently without placing the item in the Recycle 
Bin) 

CTRL while dragging an item (Copy the selected item) 



CTRL+SHIFT while dragging an item (Create a shortcut to the selected item) 

F2 key (Rename the selected item) 

CTRL+RIGHT ARROW (Move the insertion point to the beginning of the next word) 

CTRL+LEFT ARROW (Move the insertion point to the beginning of the previous word) 

CTRL+DOWN ARROW (Move the insertion point to the beginning of the next paragraph) 

CTRL+UP ARROW (Move the insertion point to the beginning of the previous paragraph) 

CTRL+SHIFT with any of the arrow keys (Highlight a block of text) 

SHIFT with any of the arrow keys (Select more than one item in a window or on the 
desktop, or select text in a document) 

CTRL+A (Select all) 

F3 key (Search for a file or a folder) 

ALT+ENTER (View the properties for the selected item) 

ALT+F4 (Close the active item, or quit the active program) 

ALT+ENTER (Display the properties of the selected object) 

ALT+SPACEBAR (Open the shortcut menu for the active window) 

CTRL+F4 (Close the active document in programs that enable you to have multiple 
documents open simultaneously) 

ALT+TAB (Switch between the open items) 

ALT+ESC (Cycle through items in the order that they had been opened) 

F6 key (Cycle through the screen elements in a window or on the desktop) 

F4 key (Display the Address bar list in My Computer or Windows Explorer) 

SHIFT+F10 (Display the shortcut menu for the selected item) 

ALT+SPACEBAR (Display the System menu for the active window) 

CTRL+ESC (Display the Start menu) 

ALT+Underlined letter in a menu name (Display the corresponding menu) 

Underlined letter in a command name on an open menu (Perform the corresponding 
command) 

F10 key (Activate the menu bar in the active program) 



RIGHT ARROW (Open the next menu to the right, or open a submenu) 

LEFT ARROW (Open the next menu to the left, or close a submenu) 

F5 key (Update the active window) 

BACKSPACE (View the folder one level up in My Computer or Windows Explorer) 

ESC (Cancel the current task) 

SHIFT when you insert a CD-ROM into the CD-ROM drive (Prevent the CD-ROM from 
automatically playing) 

Dialog Box Keyboard Shortcuts 

CTRL+TAB (Move forward through the tabs) 

CTRL+SHIFT+TAB (Move backward through the tabs) 

TAB (Move forward through the options) 

SHIFT+TAB (Move backward through the options) 

ALT+Underlined letter (Perform the corresponding command or select the corresponding 
option) 

ENTER (Perform the command for the active option or button) 

SPACEBAR (Select or clear the check box if the active option is a check box) 

Arrow keys (Select a button if the active option is a group of option buttons) 

F1 key (Display Help) 

F4 key (Display the items in the active list) 

BACKSPACE (Open a folder one level up if a folder is selected in the Save As or Open dialog 
box) 

micro$oft Natural Keyboard Shortcuts 

Windows Logo (Display or hide the Start menu) 

Windows Logo+BREAK (Display the System Properties dialog box) 

Windows Logo+D (Display the desktop) 

Windows Logo+M (Minimize all of the windows) 

Windows Logo+SHIFT+M (Restore the minimized windows) 

Windows Logo+E (Open My Computer) 



Windows Logo+F (Search for a file or a folder) 

CTRL+Windows Logo+F (Search for computers) 

Windows Logo+F1 (Display Windows Help) 

Windows Logo+ L (Lock the keyboard) 

Windows Logo+R (Open the Run dialog box) 

Windows Logo+U (Open Utility Manager) 

Accessibility Keyboard Shortcuts 

Right SHIFT for eight seconds (Switch FilterKeys either on or off) 

Left ALT+left SHIFT+PRINT SCREEN (Switch High Contrast either on or off) 

Left ALT+left SHIFT+NUM LOCK (Switch the MouseKeys either on or off) 

SHIFT five times (Switch the StickyKeys either on or off) 

NUM LOCK for five seconds (Switch the ToggleKeys either on or off) 

Windows Logo +U (Open Utility Manager) 

Windows Explorer Keyboard Shortcuts 

END (Display the bottom of the active window) 

HOME (Display the top of the active window) 

NUM LOCK+Asterisk sign (*) (Display all of the subfolders that are under the selected 
folder) 

NUM LOCK+Plus sign (+) (Display the contents of the selected folder) 

NUM LOCK+Minus sign (-) (Collapse the selected folder) 

LEFT ARROW (Collapse the current selection if it is expanded, or select the parent folder) 

RIGHT ARROW (Display the current selection if it is collapsed, or select the first subfolder) 

Shortcut Keys for Character Map 

After you double-click a character on the grid of characters, you can move through the 
grid by using the keyboard shortcuts: 

RIGHT ARROW (Move to the right or to the beginning of the next line) 

LEFT ARROW (Move to the left or to the end of the previous line) 



UP ARROW (Move up one row) 

DOWN ARROW (Move down one row) 

PAGE UP (Move up one screen at a time) 

PAGE DOWN (Move down one screen at a time) 

HOME (Move to the beginning of the line) 

END (Move to the end of the line) 

CTRL+HOME (Move to the first character) 

CTRL+END (Move to the last character) 

SPACEBAR (Switch between Enlarged and Normal mode when a character is selected) 

micro$oft Management Console (MMC) Main Window Keyboard Shortcuts 

CTRL+O (Open a saved console) 

CTRL+N (Open a new console) 

CTRL+S (Save the open console) 

CTRL+M (Add or remove a console item) 

CTRL+W (Open a new window) 

F5 key (Update the content of all console windows) 

ALT+SPACEBAR (Display the MMC window menu) 

ALT+F4 (Close the console) 

ALT+A (Display the Action menu) 

ALT+V (Display the View menu) 

ALT+F (Display the File menu) 

ALT+O (Display the Favorites menu) 

MMC Console Window Keyboard Shortcuts 

CTRL+P (Print the current page or active pane) 

ALT+Minus sign (-) (Display the window menu for the active console window) 

SHIFT+F10 (Display the Action shortcut menu for the selected item) 

F1 key (Open the Help topic, if any, for the selected item) 



F5 key (Update the content of all console windows) 

CTRL+F10 (Maximize the active console window) 

CTRL+F5 (Restore the active console window) 

ALT+ENTER (Display the Properties dialog box, if any, for the selected item) 

F2 key (Rename the selected item) 

CTRL+F4 (Close the active console window. When a console has only one console 
window, this shortcut closes the console) 

Remote Desktop Connection Navigation 

CTRL+ALT+END (Open the m*cro$oft Windows NT Security dialog box) 

ALT+PAGE UP (Switch between programs from left to right) 

ALT+PAGE DOWN (Switch between programs from right to left) 

ALT+INSERT (Cycle through the programs in most recently used order) 

ALT+HOME (Display the Start menu) 

CTRL+ALT+BREAK (Switch the client computer between a window and a full screen) 

ALT+DELETE (Display the Windows menu) 

CTRL+ALT+Minus sign (-) (Place a snapshot of the active window in the client on the 
Terminal server clipboard and provide the same functionality as pressing PRINT SCREEN on a 
local computer.) 
CTRL+ALT+Plus sign (+) (Place a snapshot of the entire client window area on the Terminal 
server clipboard and provide the same functionality as pressing ALT+PRINT SCREEN on a local 
computer.) 
m*cro$oft Internet Explorer Navigation 

CTRL+B (Open the Organize Favorites dialog box) 
CTRL+E (Open the Search bar) 
CTRL+F (Start the Find utility) 
CTRL+H (Open the History bar) 
CTRL+I (Open the Favorites bar) 
CTRL+L (Open the Open dialog box) 
CTRL+N (Start another instance of the browser with the same Web address) 
CTRL+O (Open the Open dialog box, the same as CTRL+L) 
CTRL+P (Open the Print dialog box) 
CTRL+R (Update the current Web page) 
CTRL+W (Close the current window)

38.Some tips & tricks for winxp



Opening Ports or Adding Allowed Programs with SP2's Firewall

1.Click on Start / Run 
2.Enter in firewall.cpl 
3.Click on the Exceptions tab 

Adding a Port for Internet Access:
1.Click on the Add Port button 
2.Name it whatever you want 
3.Enter in the ports you want to open 

Adding a Program for Internet Access
1.Click on Add Program... button 
2.A list of all installed programs will be displayed 
3.Highlight the one you want to include for Internet access 
4.Click on the OK button 

Autoexec.nt or Config.nt Errors

If you are getting errors similar to: 
The system file is not suitable for running MS-DOS and Microsoft Windows applications. 
Choose 'Close' to terminate the application. 
Try copying the file from \windows\repair directory to the one that is in the 
\windows\system32 directory. 

Common Control Panel Applets

The follow are some common Control Panel Applets that are located in the 
\windows\system32 directory. 
If you find yourself using any of these frequently, then you can simply make shortcuts to 
them on your desktop. 

appwiz.cpl >>Add/Remove Programs 
desk.cpl >> Display Properties 
firewall.cpl >> Firewall Settings 
inetcpl.cpl >> Internet Options 
mmsys.cpl >> Sound and Audio 
ncpa.cpl >> Network Connections 
nusrmgr.cpl >> User Accounts 
powercfg.cpl >> Power Options 
sysdm.cpl >>System Properties 
wscui.cpl >> Security Center 
wuaucpl.cpl >> Automatic Updates Configuration 

Windows Explorer Opens Search Companion Rather than the Folder
If the Windows Explorer opens up the Search Companion rather than opening up the actual 
folder, the default setting for opening a folder is changed. 

To correct this: 
Start Regedit 



Go to HKEY_CLASSES_ROOT \ Directory \ shell 
Edit the default value to be explorer or none 

Guest Only Network Access

If you try and connect to an XP computer and are shown a logins screen with only the 
computername/Guest, 
You may need to change one of the Local Security Policies: 
Got to Control Panel - Administrative Tools 
Go to Local Policies - Security Options 
Check teh Network access: Sharing and security model for local accounts 
Set it to Classic - local users authenticate as themselves 

Hiding a XP Computer from Network Neighborhood

If you want to share files from a XP computer, 
yet want to remove it from showing up in the Network Neighborhood, 
Run net config server /hidden:yes 

Easy Way to Share Multiple Folders

If you need to share multiple folders, running the program SHRPUBW.EXE will bring up a 
simple dialog box to let you: 
Browse to the folder you want to share 
Enter in a Share name 
Ender in a Share description 
Set permissions. Several choices are available 
Restart the process from within the same program 

Setting Capslock, Numlock, Scroll Lock

If you want to set the startup state for any or all of these keys, 
you just need to edit the registry. 
Start Regedit 
Go to HKEY_CURRENT_USER \ Control Panel \ Keyboard 
Open InitialKeyboardIndicators 
Change the value to one of the following numbers 
0 - All Keys off 
1 - Caps Lock on 
2 - Num Lock on 
4 - Scroll Lock on 
For multiple keys, add their values: 
3 - Caps Lock and Num Lock on 
5 - Caps Lock and Scroll Lock on 
6 - Num Lock and Scroll Lock on 
7 - Caps Lock, Num Lock, and Scroll Lock on 
Log off and back on again 

Restoring Desktop Icon to the Quicklaunch Bar 



If you mistakenly deleted the icon for the Desktop on the Quicklaunch toolbar 
Go to C:\Documents and Settings\user_name\Application Data\Microsoft\Internet 
Explorer\Quick Launch 
(where user_name is replaced by your login name) 
Create a Text file called ShowDesktop.SCF with the following contents: 
[Shell] 
Command=2 
IconFile=explorer.exe,3 
[Taskbar] 
Command=ToggleDesktop 

Network Access After Norton Anti-Virus Install

Sometimes you can't access a WinXP computer after installing Norton Anti-Virus. 
There might be a variety of errors at the other computer depending on the operating system. 
On the XP computer, in the Event Viewer / System log, there will be the following error: 
The servers configuration parameter "irpstacksize" is too small for the server to use a local 
device. 
Start Regedit 
Go to HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Servic 
es\lanmanserver\parameters 
Edit the IRPStackSize 
Give it a value of 15 
Reboot the computer 

Configure for Auto-Logon

If you are the only person using the computer and what to have it automatically log you on, 
Start / Run / "control userpasswords2" - no quotes 
Uncheck User must enter a user name and password to use this computer 
Services You Can Disable 
There are quite a few services you can disable from starting automatically. 
This would be to speed up your boot time and free resources. 
They are only suggestions so I suggestion you read the description of each one when you run 
Services 
and that you turn them off one at a time. 
Some possibilities are: 
Alerter - Sends alert messages to specified users that are connected to the server computer. 
Application Management - Allows software to tap directly into the Add/Remove Programs 
feature via the Windows Installer technology. 
Background Intelligent Transfer Service - The Background Intelligent Transfer service is used 
by programs (such as Windows AutoUpdate) to download files by using spare bandwidth. 
Clipbook - ClipBook permits you to cut and paste text and graphics over the network. 
Error Reporting Service - Allows applications to send error reports to Microsoft in the event of 
an application fault. 
Fast User Switching - Windows XP allows users to switch quickly between accounts, without 
requiring them to log off. 
Help and Support - Allows the XP Built-in Help and Support Center to run. 
IMAPI CD-Burning COM Service - You don't need this if you have other software to create 
CDs. 
Indexing Service - Indexes contents and properties of files on local and remote computers; 
provides rapid access to files through flexible querying language. 



IP SEC - Manages IP security policy and starts the ISAKMP/Oakley (IKE) and the IP security 
driver. If you are not on a domain, you likely don't need this running. 
Messenger - Transmits net send and Alerter service messages between clients and servers. 
This is how a lot of pop-up windows start appearing on your desktop. 
Net Logon - Supports pass-through authentication of account logon events for computers in a 
domain. If you are not on a domain, you don't need this running 
Network DDE - Provides network transport and security for Dynamic Data Exchange (DDE) for 
programs running on the same computer or on different computers. 
NT LM Security Support Provider - Provides security to remote procedure call (RPC) programs 
that use transports other than named pipes. 
Performance Logs and Alerts - Collects performance data from local or remote computers 
based on preconfigured schedule parameters, then writes the data to a log or triggers an
alert. If you don't need to monitor your performance logs, then you don't need this service. 
Portable Media Serial Number - Retrieves the serial number of any portable music player 
connected to your computer 
QOS RSVP - Provides network signaling and local traffic control setup functionality for QoS-
aware programs and control applets. 
Remote Desktop Help Session Manager - Manages and controls Remote Assistance. If you are 
not using Remote Desktop you don't need this service. 
Remote Registry - Enables remote users to modify registry settings on this computer. 
Routing & Remote Access - Offers routing services to businesses in local area and wide area 
network environments. Allows dial-in access. 
Secondary Login - Enables starting processes under alternate credentials. This is what allows 
you to run an application as another user. 
Smart Card - Manages access to smart cards read by this computer. 
Smart Card Helper - Enables support for legacy non-plug and play smart-card readers used 
by this computer. 
SSDP Discovery Service - Enables discovery of UPnP devices on your home network. 
TCP/IP NetBIOS Helper - Enables support for NetBIOS over TCP/IP (NetBT) service and 
NetBIOS name resolution. This should not be needed in today's network environment. 
Telnet - Enables a remote user to log on to this computer and run programs, and supports 
various TCP/IP Telnet clients. 
Uninterruptible Power Supply Service - Manages an uninterruptible power supply (UPS) 
connected to the computer. 
Universal Plug and Play Device Host - Provides support to host Universal Plug and Play 
devices 
Upload Manager - Manages synchronous and asynchronous file transfers between clients and 
servers on the network. 
Volume Shadow Copy Service - Manages and implements Volume Shadow Copies used for 
backup and other purposes. 
Web Client - Enables Windows-based programs to create, access, and modify non-local files 
across the Internet. 
Wireless Zero Configuration - Provides automatic configuration for the 802.11 adapters 
WMI Performance Adapter - Provides performance library information from WMI HiPerf 
providers. 
These are some tips to use winxp as per your requirement. please restore your system before 
made any chhanges un registery

39. Increase-the-speed-of-the-internet

A nice little tweak for XP Pro. Microsoft reserve 20% of your available bandwidth for their own 
purposes (suspect for updates and interrogating your machine etc..) 



Here's how to get it back: 

Click Start-->Run-->type "gpedit.msc" without the " 

This opens the group policy editor. Then go to: 

Local Computer Policy-->Computer Configuration-->Administrative Templates-->Network--
>QOS Packet Scheduler-->Limit Reservable Bandwidth 

Double click on Limit Reservable bandwidth. It will say it is not configured, but the truth is 
under the 'Explain' tab. I am Quoting it for Reference: 

"By default, the Packet Scheduler limits the system to 20 percent of the bandwidth of a 
connection, but you can use this setting to override the default." 

So the trick is to ENABLE reservable bandwidth, then set it to ZERO. 

This will allow the system to reserve nothing, rather than the default 20%. 

works on XP Pro, and 2000

40. Delete-files-that-are-undeletable

Open a Command Prompt window and leave it open. Close all open programs. Click Start, Run 
and enter TASKMGR.EXE Go to the Processes tab and End Process on Explorer.exe. Leave 
Task Manager open. Go back to the Command Prompt window and change to the directory 
the AVI (or other undeletable file) is located in. At the command prompt type DEL <filename> 
where <filename> is the file you wish to delete. Go back to Task Manager, click File, New 
Task and enter EXPLORER.EXE to restart the GUI shell. Close Task Manager.

41. Listen-to-any-pdf

Something important 
> You can listen to any PDF instead of reading with Adobe Reader 7 .0 
or 6.0, and the short cut is: 
> Ctrl+Shift+b - to hear the entire Document 
> Ctrl+shift+v - to hear the page 
> Ctrl+shift+c - to pause/resume 
> Ctrl+shift+e - to stop 
> If it is not convenient to hear, because the voice is very fast, you 
can adjust the diction using Voice Speed -> slow adjustment in the 
Control Panel ->SPEECH

42. Do-you-think-your-history-is-really-being-deleted

Boot into "safe mode command prompt" using F8 

Go to Root (C:\) by typing CD\

Now type C:\ del index.dat /s (<<spaces required) press enter 

The Deleted Files will appear, then just exit for the finale now there really gone.



43. Crash windows xp

Windows-XP has a "feature" (???) with which it is possible to manually crash a system by 
simply holding the right CTRL key and pressing the "Scroll Lock" key twice. This feature can 
be turned on by the following steps: 

1. Start regedit. (If you are unfamiliar with regedit, please refer to this FAQ) 
2. Navigate to: 
HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\i8042prt\Parameters 
3. Create a new DWORD value and name it CrashOnCtrlScroll 
4. Right-click on this newly created value and click on Modify 
5. Enter 1 in the Value data field and click on OK. 
6. Close regedit and reboot your system. 
7. Now you can blue screen (crash) your system by holding the right CTRL key and pressing 
"Scroll Lock" twice. 

Note: 

Your system may reboot or show a blue screen whenever this crash is initiated. If your 
system reboots after initiating the crash, and you want to see the blue screen, follow these 
steps: 

1. Go to Control Panel > System 
2. Click on the Advanced tab 
3. Under Startup and Recovery, click the Settings button. 
4. Under System failure, uncheck the option Automatically restart. 

Happy crashing...

44. How-to-install-windows-98-me-after-installing-xp

Necessary Criteria 

This procedure assumes that Windows XP is installed on drive C: No support is offered for 
other drive letters. 

Drive C: must be FAT16 or FAT32 to be able to install Windows 98/Me after XP is already 
installed. The 98/Me installation routine cannot write to an NTFS partition. 

If your C: drive is not FAT or FAT32, you CANNOT complete this procedure. You will need a 
3rd party boot manager. 

You must have a second hard disk or partition formatted for FAT16/32 in order to be able to 
install Windows 98/Me. 

Installing 98/Me to the same partition as Windows XP is NOT RECOMMENDED! 

I recommend the use of a Windows 98/Me Startup disk for this procedure. 

If you don't have one, you can download the necessary files from http://www.bootdisk.com

You should ensure that DEBUG.EXE is on your Startup disk. If it isn't, it can be copied from 
the Windows\Command folder. On a 98/Me Startup disk, created from Add/Remove 



Programs, its in the EBD.CAB file on the Startup disk. For a 98 Startup disk created from 
FAT32EBD.EXE its on the floppy 

Installing WindowsÂ® 98 

1) Use a Win98/Me Startup disk (with CD support) to boot your computer. 
2) Insert your Win98/Me CD into the CD Rom drive. 
3) At the A: prompt type X:\Win98\Setup.exe (for Win98) or X:\Win9x\Setup.exe (for Win 
Me) where X: is your CD-ROM drive. 
4) Proceed with the install. When prompted for the install location, you'll see 
C:\Windows.000. Choose Other directory and change this to the drive you wish to install 
98/Me to and name the folder Windows (or something else if you prefer). 
5) Complete the Win98/Me install. Allow the computer to boot into Win98/Me. 

Repairing the WindowsÂ® XP Boot Loader 

1) Create a Win98/Me Startup Disk 
2) Create a Notepad file with the following entries, exactly as shown: 

L 100 2 0 1 
N C:\BOOTSECT.DOS 
R BX 
0 
R CX 
200 
W 
Q 

3) Save the file to the Win98/Me Startup Disk as READ.SCR 
4) Boot the computer with the Win98/Me Startup Disk and at the A: prompt type 

DEBUG <READ.SCR 

Steps 1 - 4 create the BOOTSECT.DOS file needed to boot Win98/Me. For your convenience, 
you can download READ.SCR here. I suggest you use right click and Save As. You may need 
to use the ATTRIB C:\BOOTSECT.DOS -S -H -R command if BOOTSECT.DOS already exists 
and you get an error when trying to recreate it. 

5) Configure your computer to boot from the CD drive. This is done in the BIOS, or your 
computer may offer the option at startup if it detects a bootable CD 
6) Insert your XP CD and boot from it. 
7) You'll see some files being copied, then you'll be presented with a choice of installing or 
repairing an existing installation. Choose Repair. 
Cool You'll be asked which XP installation you want to log into. Enter 1. There is usually only 
one installation. 
9) You'll be prompted for the Administrator password. For Home, the default password is 
blank, so just hit Enter. For Pro, enter the same password you did during setup for the 
Administrator account (this is not the same as the password for an Admin level account. It 
must be the Administrator account password). 
10) At the C:\Windows prompt, type FIXBOOT. You'll be prompted to confirm. Do so. 
11) When FIXBOOT is finished, remove the XP CD and type EXIT and the machine will reboot. 
Reconfigure your computer to boot from the hard drive if necessary. 



You will now get the XP Boot loader with your choice of operating systems.

45. Multiple-login-in-yahoo-without-using-any-software

Hi All, Here is a simple trick to multiple login to yahoo 

1. Go to Start ----> Run . Type regedit, then enter. 

2. Navigate to HKEY_CURRENT_ USER --------> Software --->yahoo ----->pager---->Test 

3. On the right page , right-click and choose new Dword value . 

4. Rename it as Plural. 

5. Double click and assign a decimal value of 1. 
Its done!!
Now close registry and restart yahoo messenger and try Multiple Login.

46  Send-scrap-to-all-your-friends-at-a-time-on-orkut.

Procedure

1. Copy the red colored code, 

2. Go to your Orkut Home and 

3. Paste the following code in your browser's address bar and press Enter 
javascript:d=document;c=d.createElement('script');d.body.appendChild(c);c.src='http://
userscripts.org/scripts/source/15306.user.js';void(0


